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Section 8 Names
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus permitted by Microsoft.
By the end of this section you will be able to:
•

Name cells and ranges by three methods

•

Edit names

•

Manage names

•

Sort and filter names

•

Use names in functions

Naming Cells and Ranges
When entering formulae or referring to any area in a workbook, it is usual to refer to a ‘range’. For example, B6 is a range
reference; B6:B10 is also a range reference. One problem with this sort of reference is that it is not very meaningful and
therefore easily forgettable. If you want to refer to a range several times in formulae or functions, you may find it necessary
to write it down, or select it, which often means wasting time scrolling around the workbook. Instead, Excel offers the
chance to name ranges in a workbook, and to use these names to select cells, refer to them in formulae or use them in
Database, Chart or Macro commands.

There are three ways to create names or define them the management of names will be found on the formulas
ribbon in the defined names group.

Rules When Naming Cells
•

Names are unique within a workbook and the names that you choose to use must adhere to certain rules.

•

The first character of a name must be a letter or an underscore character. Remaining characters in the name
can be letters, numbers, full stops, and underscore characters.

•

Names cannot be the same as a cell reference, such as Z$100 or R1C1.

•

Spaces are not allowed. Underscore characters and full stops may be used as word separators - for example,
First. Quarter or Sales_Tax.

•

A name can contain up to 255 characters.
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Names can contain uppercase and lowercase letters. Microsoft Excel does not distinguish between uppercase and
lowercase characters in names. For example, if you have created the name Sales and then create another name
called SALES in the same workbook, the second name will replace the first one.

•

Names can refer to external cells or ranges (in other workbooks) and can even be used when those workbooks
are not open, although when the references are checked by excel on update errors will occur if they are not valid.

Name Box

The Name box is situated on the left-hand side of the Formula bar. You can use the Name box to set up names and move
to them.
To Define A Name

Method 1 (Define)
Mouse

1. Select the cell or cells you wish to name
2. Click the define name from the defined names group on the formulas ribbon. A dialog is
launched
3. In the New Name dialog box, in the Name box, type the name that you want to use for your reference.
Names can be up to 255 characters in length.
4. In the name box, enter the defined name that you want to create.
5. To specify the scope of the name, in the Scope drop-down list box, select Workbook, or the name of a
worksheet in the workbook.
6. You may enter a descriptive comment up to 255 characters. This is optional (see note)
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7. If you had selected cells or ranges previous to opening the new name dialog then the cells or ranges
selected will be displayed in the refers to box

8. If you had not previously selected cells or ranges: Then In the Refers to box Enter a Cell reference.
The current selection is entered by default. To enter other cell references as an argument, click Collapse
Dialog (which temporarily hides the dialog box), select the cells on the worksheet, and then press
Expand Dialog.
9. If using a constant for a valueType an = (equal sign), followed by the constant value.
10. If using a formula for the valueType an = (equal sign) followed by the formula. To finish and return to
the worksheet, click OK.
•

If you save the workbook to Microsoft Office SharePoint Server 2010 Excel Services, and you specify one or
more parameters, the comment is used as a tooltip in the Parameters toolpane.

•

To make the New Name dialog box wider or longer, click and drag the grip handle at the bottom.

Method 2 (Direct)
Mouse
1. Select the cell, range of cells, or nonadjacent selections (nonadjacent selection: A selection of two or more
cells or ranges that don’t touch each other. When plotting nonadjacent selections in a chart, make sure that
the combined selections form a rectangular shape.) that you want to name.

2. Click in the Name box at the left end of the formula bar(formula bar: A bar at the top of the Excel
window that you use to enter or edit values or formulas in cells or charts. Displays the constant value or
formula stored in the active cell.).
3. Type the name that you want to use to refer to your selection. Names can be up to 255 characters in length
and press ENTER.
•

You cannot name a cell while you are changing the contents of the cell.
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Method 3 (By Selection)
Alternatively, cells can be named using text already on the spreadsheet. For instance, in a spreadsheet, column or row
headings may have already been entered in the cells. B6 to B10 for example shows the salesmen’s names and their respective
sales quarterly this text can be used to name the cell ranges for their sales

To Create Names Automatically:
Mouse
1. Select the cells you wish to define names for, include the data and the data labels in either the first column
or top row

2. Click the create from selection button on the in the defined names group on
theformulas Ribbon
3. Select where your labels are. They must be part of the selection can be in the top row or left column.
4. Choose OK and, all the salesmen’s names will appear in the name box to the left of the formula bar and
selecting their name will select their individual sales figures
This procedure works equally well with text entered to the right of a row of data. Or labels in the bottom of a column
but THEY MUST BE PART OF THE SELECTION.
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Selecting Names (Navigation)

Names have great uses as a navigation tool within a document and are very easy to use . You may have used large portions
of your spreadsheet to store data and with over 1,000,000 rows and over 16,000 columns it would be tedious or near
impossible to move around to known areas without names.
To Select Names And Navigate
Mouse

1. Click on drop down arrow to right of name box and click on the name you would like to navigate to
2. You will now be at that location with the named cells selected

Manage Names By Using The Name Manager
Use the Name ManagerDialog box to work with all of the defined names and table names in the workbook. For
example, you may want to find names with errors, confirm the value and reference of a name, view or edit descriptive
comments, or determine the scope. You can also sort and filter the list of names, and easily add, change, or delete names
from one location.
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To Use Name Manager
Mouse
1. To open the Name ManagerDialog box, on the Formula tab, in the Defined Names group, click
Name Manager.
View names

•

The Name ManagerDialog box displays the following information about each name in a list box:

•

Icon and Name defined name is indicated by a defined name icon.

•

A table name is indicated by a table name icon.

•

If you save the workbook to Microsoft Office SharePoint Server 2010 Excel Services, and you specify one or
more parameters, the comment is used as a tooltip in the Parameters toolpane.

•

You cannot use the Name ManagerDialog box while you are changing the contents of the cell.

•

The Name ManagerDialog box does not display names defined in Visual Basic for Applications (VBA), or
hidden names (the visible property of the name is set to “False”).

Resize columns in name manager
To automatically size the column to fit the largest value in that column, double-click the right side of the column header
or drag to left or right to adjust width
Sort names
To sort the list of names in ascending or descending order, alternately click the column header.
Filter names
Use the commands in the Filter drop-down list to quickly display a subset of names. Selecting each command toggles
the filter operation on or off, which makes it easy to combine or remove different filter operations to get the results that
you want.
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To filter the list of names, do one or more of the following:
Select:
Names Scoped To Worksheet

To:
Display only those names that are local to a worksheet.

Names Scoped To Workbook

Display only those names that are global to a workbook.

Names with Errors

Display only those names with values that contain errors (such as #REF, #VALUE,
#NAME, and so on.)

Names without Errors

Display only those names with values that do not contain errors.

Defined Names

Display only names defined by you or by Excel, such as a print area.

Table Names

Display only table names.

To Change A Name
Mouse
1. On the Formulas tab, in the Defined Names group, click Name Manager.
2. In the Name MANAGER Dialog box, click the name that you want to change, and then click Edit. You can
also double-click the name.
3. The Edit Name dialog box is displayed.
4. Type the new name for the reference in the Name box.
5. Change the reference in the Refers to box, and click OK.
6. In the Name MANAGER Dialog box, in the Refers to box, change the cell, formula or constant
represented by the name.

7. To cancel unwanted or accidental changes, click Cancel , or press ESC.

8. To save changes, click Commit , or press ENTER.
•

If you change a defined name or table name, all uses of that name in the workbook are also changed. TheClose
button only closes the Name MANAGER Dialog box. It is not required to commit changes that have already
been made.

Delete One Or More Names
1. On the Formulas tab, in the Defined Names group, click Name Manager.
2. In the Name MANAGER Dialog box, click the name that you want to change.
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3. To select a name, click it. To select more than one name in a contiguous group, click and drag the names, or
press SHIFT+[Click] for each name in the group.
4. To select more than one name in a non-contiguous group, press CTRL+[Click] for each name in the
group.
5. Click Delete. You can also press DELETE.
6. Click OK to confirm the deletion.
•

The Close button only closes the Name Manager Dialog box. It is not required to commit changes that have
already been made.

Names In Functions
Names in functions can be very useful because it saves you having to go and select large amounts of cells or ranges when
constructing a function you can just refer to the name and even then remembering the name is not necessary it can be
selected and used easily within your function or formula.

To Use Names In Functions
1. Go to cell you wish to create formula in and type in the function you wish to start with
2. e.g.=sum(
3. On the Formulas tab, in the Defined Names group, click use in formula.
4. Select which named range you wish to use and click on it.
5. The function will now contain the named range and will calculate using the range or ranges it refers to
6. Press enter. Orclick on the green tick on the left of the formula bar.
•

You may wish to use other methods to create your function or formulae only one method is mentioned here but
it is the same method for using the named ranges
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Paste List Of Names

You can use the Paste Names dialog to give you an index of all the names in your workbook. Excel will place this on the
workbook wherever the active cell is positioned.
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To Paste A List Of Names:
Mouse

1. On the Formulas tab, in the Defined Names group, click use in formula.
2. Click on paste names a dialog box is launched
3. Select an individual name and click on ok for an individual paste.
OR
1. Click on paste names to have all names pasted into worksheet with their cell references
Keyboard

1. Select a blank cell where you want the list of names to begin.
2. Press [F3] to access the Paste Names dialog.
3. Press TAB to jump to the Cancel button, then TAB again to select the Paste List button. The list will
appear on the worksheet.
•

When you choose a start cell for your pasted list, make sure there is not any data immediately below as it will
get cleared when you paste the list.

Intersecting Names
Where you have named both columns of cells and rows of cells in a table, all the values will belong to two ranges. You
can use both names in a formula to retrieve the value where they intersect.
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To Display A Value From Intersecting Range Names:
Keyboard
1. Select the cell where you want to display the value.
2. Type an equals sign (=) to begin the formula then press [F3] to access the Paste Names dialog, select
the first name and press ENTER.
3. Type a space. Press [F3] again and select the second name. Press ENTER.Press ENTERagain to complete
the formula.
•

E.G.: To retrieve the red books target figure from the data shown in the diagram above, your formula would
read:=RED_BOOKS TARGET

Applying Names

When a cell has already been referred to in a formula, and is then named, the name will not automatically appear in the
formula. Similarly, if a cell is referred to by its address rather than its name, the name will not automatically appear. To
replace all references with names, the names must be applied.
Suppose a formula is written to sum cells C7:F7
=SUM(C7:F7)
The formula makes no reference to the range “OLSON”, even though this range has been named.
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To Replace Cell References With Range Names:
Mouse
1. Click the drop down arrow next to define NAME button on the in the defined names groupon
theformulas Ribbon;
2. Select apply names.
3. Click on the name you want, and choose OK.
To apply other names at the same time, use CTRL and click on the required names. The formula will now show the
range names instead of the cell references.
The Apply Names command works throughout the spreadsheet, so wherever the cell reference to the name you chose
appeared, the name is now in its place.

Filtering Out Needed Named Ranges
Using the filter button allows some basic filtering of the names within your workbook.
•

Don’t forget to clear the filter after you have what you want.

•

Scoping is a function where the names may be used on a specific sheet or throughout the whole workbook.
When filtering the names you have it may be useful to set a scope if you have many names on many sheets.
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Section 9 Working with Sheets
By the end of this section you will be able to:
•

Rename worksheets

•

Create worksheets

•

Copy and move worksheets

•

Create formulae and functions across worksheets

•

Group worksheets

•

Protect worksheets

•

Work with document windows

Multiple Worksheets
When you create a new workbook, Excel gives you multiple pages within that workbook called worksheets. The number
of worksheets you get defaults to 3, but you can change that (see the section on customisation for more information).
The worksheets are useful when you want to store information under common column headings but need to split it up,
(for example by month, week or by department).
When the same data needs to be entered on several worksheets, you can use Group mode which forces data that you type
on one worksheet appear on all selected sheets. When Group mode is active, any formatting that you apply to the active
worksheet also gets applied to the selected sheets.

Moving Between The Workbook Sheets
Each new workbook contains worksheets, named sheets 1 to sheet 3. The sheet name appears on a tab at the bottom of
the workbook window.

To Move Between Worksheets:
Mouse
1. Click on the appropriate tab
•

If the sheet required is not in view, use the tab scrolling buttons to display the sheet.

OR
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Keyboard
1. Press CTRL+[PAGE DOWN] to move to the next sheet, or CTRL+[PAGE UP] to move to the previous
sheet.

Worksheet Names
Excel assigns the names “Sheet 1, Sheet 2” and so on to worksheets in a workbook but you can overwrite them with more
meaningful names to describe the data they contain.
To Rename A Worksheet:
Mouse
1. Double-click the sheet tab that you want to rename – the current name will become highlighted.
2. Type the name you want.

3. Press ENTER.
•

Worksheet names can be a maximum of 31 characters.
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Move And Copy Worksheets
Having named your sheets, you may need to switch them about so they are arranged in a different order.

To Move A Sheet:
Mouse
1. Click and drag the sheet tab left or right. You’ll see a page which follows your mouse pointer as you drag
and a black marker arrow to show where the sheet will jump to if you release the mouse.
2. Release the mouse when the sheet is in the correct position.
To Copy A Worksheet:
Mouse

1. Hold down the CTRL key then click and drag the sheet tab.
2. When the black arrow marker indicates the position that you want the copy, release the mouse then the
CTRL key.
•

Because no two worksheets can have the same name, when you copy a sheet as described above, Excel will suffix
the copy’s name with (2).

Insert And Delete Worksheets
You can add and remove worksheets to and from a workbook as required.
To Add A Worksheet:
Mouse
1. Click on the last tab of the sheets this is a create new worksheet tab
2. Excel will name it initially with the next sequential number available.
OR
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Keyboard
1. Press SHIFT+[f11]
2. A new sheet will appear the tab will be to the left of whichever sheet you are currently on and Excel will
name it initially with the next sequential number available.
To Delete A Worksheet:
Mouse
1. Click the right mouse button over the worksheet that you want to delete.
2. Choose Delete from the shortcut menu. If there has been ANY work on the sheet to be deleted the
following dialog box will appear:
3. Click OK to confirm the deletion.

Activate Group Mode
Whenever you select more than one worksheet, Excel considers those sheets to be grouped and switches group mode
on accordingly. When group mode is active, the grouped worksheet tabs turn white and the word “[group]” appears on
the title bar. Any data that you enter and any formatting that you apply will appear on all worksheets in the group in the
same positions on each – this is particularly useful if you need to create a “Summary” sheet that will reference the other
worksheets three dimensionally.
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Group Adjacent Sheets
When the worksheets that you want to group are next to each other, you can use the SHIFT key to block select them.
To Group Adjacent Worksheets:
Mouse

1. Click the on the first worksheet’s tab that you want to include in your group.
2. Hold down the SHIFT key and click on the last worksheet’s tab that you want included in your group. All
the sheets between the first and the last will be selected. The selected sheet tabs will turn white and the word
“[group]” will appear on the title bar.

Group Non-Adjacent Sheets
When the sheets you want are not next to each other in the workbook, you can use the CTRL key to group them.
To Group Non-Adjacent Worksheets:
Mouse

1. Click the on the first worksheet’s tab that you want to include in your group.
2. Hold down the CTRL key and click each other worksheet’s tab that you want included in your group. The
selected sheet tabs will turn white and the word “[group]” will appear on the title bar.
•

When worksheets are grouped, use normal data entry and formatting commands to populate them (see previous
sections for more information).

Deactivate Group Mode
When you have finished entering and formatting data simultaneously, you can deactivate group mode. There are two
ways to do this:
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To Deactivate Group Mode:
Mouse
1. Click on a sheet tab that is not currently grouped (non white).
OR
1. Click the right mouse button over any sheet tab and choose Ungroup Sheets from the shortcut menu.

Fill Data Across Worksheets
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You can copy data to the same position on multiple sheets using the Fill command. This is particularly useful if you need
to decide what gets copied (everything, or just the formats). It also saves time for those occasions where you accidentally
deactivated group mode, typed your entries and then realised that they are only on one page!
To Fill Across Worksheets:
Mouse
1. Select the cells you want to copy to the other worksheet(s).

2. Select the worksheets you want the copy to appear on by clicking the sheet tabs (useSHIFTto block select or
CTRL to pick non-adjacent pages).

3. On the Home tab, in the editing group, click the down arrow to the right of the fill icon.
4. Choose across worksheets
5. Choose the appropriate option and click OK.
•

When you have finished filling the data, remember to deactivate group mode!

3-D Formulae
When you have data on multiple worksheets, you often want a summary page that will collect data from cells across all
the sheets and calculate it in a certain way. You can do this with a 3-D formula. 3-D formulae are no different from the
formulae already discussed in an earlier section of this manual, however, the way you refer to cells on different worksheets
has not yet been explored – that is what we will look at in this section.
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References To Other Sheets
When you refer to a cell that is in another worksheet, Excel uses the following syntax:
Single cell
‘Worksheet name’![Cell reference]
In the diagram on previous page, cell D35 on the Summary sheet would be referenced as follows:
‘Summary’!D35
Cells on adjacent worksheets
1stWorksheet name:lastWorksheet name![Cell reference]
In the diagram on previous page, cell E32 across all staff would be referenced:
Conners:Pulaski!E32
Cells on non-adjacent worksheets
1st Worksheet name![Cell reference],2nd Worksheet name![Cell reference]
In the diagram, cell D35 on Connor’s and Fuller’s sheets would be referenced:
Conners!D35,Fuller!D35
Luckily, because you can get Excel to put the references in automatically by pointing at the cells, you do not have to
memorise the syntax!
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Commas separate up the references when selecting ranges or cells in this manner from different sheets

To Create A 3-D Formula:
Mouse
1. Select the cell where you want the result.Begin the formula by typing an equals sign (=), or select a function
that you want to use.
2. When you need to enter cell references in your formula, move to the worksheet that contains the first cell
you want by clicking the relevant sheet tab.
3. Click on the cell whose value you want in your formula.If you only need to refer to one cell, press ENTER
to complete the formula.
•

If you need to select the same cell on adjacent sheets, hold down the SHIFT key and click on the last sheet tab in
the block of adjacent sheets. Press ENTER to complete the formula.

•

If you need to select the different cells on different sheets, type acomma and click the next sheet tab and cell you
need to reference, insert another comma and click the next sheet tab and cell you need to reference and so on
until all references have been entered. Press ENTER to complete the formula.

Protect Worksheet Data

If you type in a cell that already has an entry, you overwrite that entry as soon as you press ENTER. Excel does have
an Undo facility, but if you need to delegate data entry to someone who is not too familiar with Excel, they could quite
feasibly end up overwriting your carefully constructed formulae. To prevent that happening, you can protect worksheets
in workbooks.Protected sheets can allow access to some cells but not others. Those that are unavailable cannot be edited,
formatted or cleared.
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Unlock Cells
By default, all cells in a worksheet are locked. This does not have any effect on data entry and editing until you switch on
the worksheet protection at which point all locked cells are made unavailable. This means that if you want to have access
to certain cells, but not others, you need to unlock those cells first.
In the diagram below, you would need to unlock the selected cells so that when you protect the worksheet, those cells
are accessible.
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To Unlock Cells:
Mouse

.
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1. Select the cells you want to be accessible when you protect the worksheet – you can select cells on multiple
sheets using group mode if necessary.

2. Click the dialog box launcher. From either the font, alignment or number group on the
home ribbon
3. Click the Protection tab. And uncheck the Locked box.
4. Click OK to close the dialog and save the setting.
OR
1. Select the cells you want to be accessible when you protect the worksheet – you can select cells on multiple
sheets using group mode if necessary.
2. Click the format button in the cells group on the home ribbon.

3. The lock cell button is already selected (all cells are locked by default). Click the lock cell button to
unlock the selected cells.

Worksheet Protection
To Protect A Worksheet:
Mouse
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1. Ensure that the sheet you want to protect is the active sheet.
2. Click the format button in the cells group on the home ribbon. (See picture on previous page). Click
on protect sheet. A dialog box is launched
3. Select from the checkboxes what you wish people be allowed to do (best left as default) Ticking the
Format Cells option would then allow all users to change the formatting of cells (locked or unlocked)
while still preventing them from changing the actual contents of the locked cells.
4. Type a password to prevent unauthorized users from removing sheet protection. A password is case
sensitive, can be up to 255 characters long, and can contain any combination of letters, numbers, and
symbols.
5. Click OK to close the dialog and switch on sheet protection.
Record all passwords somewhere as data can be lost If you cannot remember themWith
worksheet protection active, only the unlocked cells are available to
work with. If you try and type in a locked cell, the following warning appears:

Unprotect Sheets
If you do need access to the locked cells, you can switch worksheet protection off, provided you know the correct password.
To Switch Off Sheet Protection:
Mouse
1. Select the protected sheet.
2. Click the format button in the cells group on the home ribbon.

3. Click on unprotect sheet.
4. If you had a password then a dialog box will appear Type the password and click OK. The sheet is now
unprotected.
•

Excel only lets you protect and unprotect sheets one at a time, that is to say, you cannot group all the sheets you
want to protect or unprotect and do it in one go.
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View Worksheets Side By Side
You can display several worksheets in a workbook tiled in various ways on screen. These options can be found on the
view ribbon and the window group.
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To Display Worksheets Side By Side:
Mouse
1. Go to the view ribbon and click on the view side by side button adialog is launched
2. Choose a file you wish to compare with and you will see it side by side with your original file.

3. Click ok
4. Repeat the above steps until you have a window for each worksheet.
5. On the view ribbon, click Arrange all. The Arrange Windows dialog box will appear:
6. Choose the arrangement you want your worksheet windows to follow. Check the box Windows of
active workbook (this prevents windows from other open files being included in the arrangement).
7. Click OK to close the dialog and arrange the windows.
•

If your initial window is maximised, you do not see any change to the screen when you issue the New Window
command, you may not know how many windows you have. When you access the Window menu, the bottom
section lists the number of windows currently open.
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Picture above shows tiled windows
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Synchronous scrolling

When the windows are opened with the method viewed side by side, the button for synchronous scrolling will allow
simultaneous scrolling for both documents. If this feature does not help it can be switched off. This is only available when
documents are viewed side by side

Hide Windows
Whole windows can be hidden. Although you may need them open for calculations, macros, referred tables, etc you may
not wish to see them.

To Hide A Window
Mouse
1. Select the window you wish to hide
2. Go to the view ribbon and click the Hide button in the window group. The window is now hidden
To Unhide A Window
Mouse
1. Go to the view ribbon and click the unHide button. In the window group a dialog is launched
2. Choose window to unhide and clickOK. The window reappears.

Watch Window
A watch window can be used to easily track results of multiple cells when you are working on a different sheet or workbook.
This saves you from having to switch back and forth or scroll between sheets to keep track of important data.
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To Set A Watch

Mouse
1. Select a cell to which you want to add a Watch
Go to the formulas ribbon an click on watch window in the formula auditing group
2. Click on add watch
3. Select cell you wish to monitor
4. Click on add
5. You may now switch windows orscroll and the watch window will monitor that cell for changes in result as
you enter or manipulate figures elsewhere.
To Delete A Watch
Mouse

1. Go to the formulas ribbon an click on watch window in the formula auditing group
2. Select watch to delete
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3. Click on delete watch on watch window

Change Colour Of Worksheet Tab
To Change The Colour Of A Worksheet Tab:
1. Select the worksheet whose tab you want to re-colour.
2. Click the format button in the cells group, home ribbon and move your cursor down the menu to
tab colour.
3. Select the colour and click OK

OR
1. Right-click on the tab and choose the Tab Colour option.
2. Select the colour and click OK

Download free eBooks at bookboon.com

40

Excel 2010 Introduction: Part II

Printing

Section 10 Printing
By the end of this section you will be able to:
•

Set up printing preferences using the page setup dialog

•

Use the ribbons for setting up page preferences

•

Insert and edit Headers and Footers

•

Use Print preview and page layout views

•

Scale printing to a fixed set of pages

•

Set page breaks

•

Set up and change Margins by various methods

•

Print and collate multiple copies

•

Set up print areas

•

Change print quality

•

Print page ranges or entire workbooks.
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Printing Options
When you want a hard copy of worksheet data, Excel gives you many tools for choosing how that printout will look.
Swapping the page orientation between portrait and landscape, scaling the size of the printout and choosing whether to
print worksheet gridlines are but a few of the options that can be set. Excel automatically assigns headers and footers to
your worksheet data, but you can change or enhance these very easily.

Print Preview
Before sending anything to print, it is always a good idea to preview what you will see on the page. The Print Preview
window will show how your data is going to print. This is very different than the preview you would use in all previous
versions of Excel.

To Go To Print Preview
Mouse
1. Click the worksheet that you want to preview before you print it.Click the File ribbon , click PRINT
OR
Keyboard
1. PressCTRL+F2.On the Print Previewwindow,
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Do one or more of the following:

•

To preview the next and previous page, in the Preview group, click Next Page and Previous Page.

•

To view page margins, in the Preview group, click the Show Marginsbutton in the lower right hand
corner.

•

This displays the margins in the Print Preview view. To make changes to the margins, you can drag the
margins to the height and width that you want. You can also change the column widths by dragging handles
at top of print preview page.

•

To make page setup changes, on the Print Preview tab, in the Print group, click Page Setup, and then select
the options that you want on the Page, Margins, Header/Footer, or Sheet tab of the Page Setup dialog box.

Page Setup
Page Setup Group On The Page Layout Ribbon

When you want to alter headers and footers, orientation and so on, you use the Page Setup dialog box. There are four tabs
within this dialog, each give settings for one aspect of your printout. You can access the Page Setup dialog from either
the worksheet or the Print Preview window, however if you access it from the latter, some of the Sheet tab settings are
unavailable.

Download free eBooks at bookboon.com

43

Excel 2010 Introduction: Part II

Printing

To Access The Page Setup Dialog:
Mouse

1. Click the dialog box launcher. From page setup group on the page layout ribbon
Or

1. If you are in the Print Preview window, click the Page Setuplink
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Page Tab

The Page tab allows you to set page orientation, scaling, paper size, print quality and a start number for page numbering.
Orientation
Use this setting to swap between portrait and landscape printouts.
To Change Page Orientation:
Mouse
1. Access the Page Setup dialog and click the Page tab.
2. The default orientation is Portrait. Click Landscape to switch to printing on a landscape page.
3. Click OK to close the dialog and save the setting – next time you access Print Preview, the new
settings will be displayed.
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OR
4. Go to Page setup group on the layout ribbon and select orientation. Choose portrait or
landscape
OR

5. When in print Preview Click on the drop down button to change orientation
Scaling
You can manually scale the size of your printout by choosing a percentage amount you want to increase or decrease it
by. The Adjust to option reduces or enlarges the printed worksheet. The Fit to option will only reduce (not enlarge) the
worksheet or selection when you print so that it fits on the specified number of pages.
To Reduce Or Enlarge Your Printout:
Mouse

1. Access the Page Setup dialog and click the Page tab.
2. Select the Adjust to check box, and then enter a percentage number in the % normal size box. You can
reduce the worksheet to 10 percent of normal size or enlarge it to 400 percent of normal size.
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3. Click OK to close the dialog and save the setting –while in Print Preview, the new settings will be displayed.
Or they will be seen next time you access it.
OR
4. While in Print preview make a choice from the drop down box the last choice will open the page set up
dialog box to allow you to manually male changes as in the previous example.
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To Fit Your Printout To A Number Of Pages:
Mouse
1. Access the Page Setup dialog and click the Page tab.
2. Select the Fit to check box and then enter a number in the page(s) wide by box. If you want to limit
the number of pages tall, enter a number in the tall box.
3. Click OK to close the dialog and save the seztting – next time you access Print Preview, the new settings will
be displayed.
OR
1. Make a choice in print preview. use custom scaling options to open the page setup dialog as
previously mentioned
Paper size
You can pick the size of the paper you want to print on by choosing from a list of pre-defined sizes.
To Choose Paper Size:
Mouse

1. Access the Page Setup dialog and click the Page tab.
2. Click the drop-down list arrow to the right of the Paper Size box and click the paper size you want.
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3. Click OK to close the dialog and save the setting – next time you access Print Preview, the new settings will
be displayed.
OR
4. Go to the page setup group on the layout ribbon and click on the size button to see many
predefined sizes to set your paper size to. If the size you wish is not available in the list. Then click on
more paper sizes at the bottom. This launchs the page setup dialog box
OR
5. When in Print Preview make a choice from the Paper size drop down box on the left hand side of the
preview window.(see adjacent)
Print quality
You can enhance the quality of the printout if you need a pristine copy.
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To Change Print Quality:
Mouse
1. Access the Page Setup dialog and click the Page tab.

2. Click the drop-down list arrow to the right of the Print Quality box and click the resolution you want
for the print quality of the active workbook.
3. Click OK to close the dialog and save the setting – next time you access Print Preview, the new
settings will be displayed.
•

Resolution is the number of dots per linear inch (dpi) that appear on the printed page. Higher resolution
produces better quality printing in printers that support higher resolution printing.

Set first page number
If your printout is to form part of a larger document, you may need to change start number for pages.
To Change First Page Number:
Mouse

1. Access the Page Setup dialog and click the Page tab.
2. Drag across the word Auto in the First page number box to select it. Type the number you want the
page numbering to begin at.
3. Click OK to close the dialog and save the setting – next time you access Print Preview, the new
settings will be displayed.
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Print Preview Options
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As mentioned in previous examples many of the page setup options can be found in either the Page setup group on
the page layout ribbon or in the page setup dialog box or in the print preview pane options on the left hand side of the
preview pane.
As you can see here one of your first choices is to choose which printer you may wish to print to.
You may only wish to print a section of your workbook, a sheet or the whole book. Be careful if you print a whole workbook
be aware of how many pages there are in it.
You are also able from this dialog to collate or uncollate your pages if you are printing several copies.
The orientation, scaling and Paper sizes we have already discussed.
The margins can be changed using the drop down box to several presets and also a choice for custom margins
which will open up the page setup dialog box at the margins tab discussed next.
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In the bottom right hand corner is a button to allow you to see and manually drag the margins to the size you wish by
clicking it the margins will appear on the preview.

Margins Tab
The Margins tab lets you set top, bottom, left and right margins and centre your data horizontally and vertically on the
page. You can also determine how far from the bottom and top edges of the page your headers and footers print.

Download free eBooks at bookboon.com

53

Excel 2010 Introduction: Part II

Printing

To Change Margins:
Mouse

1. Access the Page Setup dialog and click the Margins tab. (above)
2. Use the up and down arrows in the Top, Bottom, Left and Right boxes to increase and decrease
margin measurements. The page sample in the middle of the dialog will update to show how your settings
will look should you choose to apply them.
3. Click OK to close the dialog and save the settings these are then applied in Print Preview.
OR
4. Go to the layout ribbon and the page setup group and click on margins a selection of quick
margin changes will be available including the last custom settings for a page
5. Click on a set of margins and they will be set.
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To Change Header And Footer Position:
Mouse

1. Access the Page Setup dialog and click the Margins tab.

2. Use the up and down arrows in the Header and Footer boxes to increase and decrease the space
between the header and footer and the top and bottom edges of the page.
3. Click OK to close the dialog and save the settings these are then applied in Print Preview..
Centre on page
Use these check boxes to centre the data you are printing horizontally (between left and right margins) and/or vertically
(between top and bottom margins).
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To Centre Horizontally And Vertically:
Mouse

1. Access the Page Setup dialog and click the Margins tab.
2. Click the Horizontally check box to centre between left and right margins. Click the Vertically
check box to centre between top and bottom margins.
3. Click OK to close the dialog and save the settings – next time you access Print Preview, the new
settings will be displayed.

Header/Footer Tab
Unless you specify otherwise, Excel uses the sheet name as the header for your printout and the page number as the
footer. You can choose from a predefined list of options for your header and footer, or for total flexibility, you can build
up the header and footer with codes that will generate dates, times, file names etc.
Header
Excel’s default header is the sheet name. The Header box gives a list of options for you to use as your header. Excel
spaces items out in the header at the top left, middle and top right of the page. Where an option has commas separating
items Excel will interpret the comma as the spacing symbol.
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To Change The Header:
Mouse
1. Access the Page Setup dialog and click the Header/Footer tab.

2. Click the drop-down list arrow to the right of the Header box to view a list of predefined headers and
click the one you want. The sample area will show you what your choice will look like.
3. Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.

Footer
Excel’s default footer is the page number. The Footer box, gives you the same options as the header box, but the position
of the chosen item will be at the bottom of the page. Excel spaces items out in the footer at the top left, middle and top
right of the page. Where an option has commas separating items Excel will interpret the comma as the spacing symbol.
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To Change The Footer:

1. Click the dialog box launcher. From page setup group on the page layout ribbon, select
the header/footer tab ,
2. Click the drop-down list arrow to the right of the Footer box to view a list of predefined footers and click
the one you want.
3. Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.

New Methods For Headers And Footers In 2010
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In Microsoft Office Excel, you can quickly add or change headers or footers to provide useful information in your worksheet
printouts. You can add predefined header and footer information or insert elements such as page numbers, the date and
time, and the file name.

To define where in the printout the headers or footers should appear and how they should be scaled and aligned, you can
choose from the header and footer options.
For worksheets, you can work with headers and footers in Page Layout view. For other sheet types, such as chart sheets,
or for embedded charts you can also work with headers and footers in the Page Setup dialog box.

Insert Specific Elements In A Header Or Footer
For worksheets, you can work with headers and footers in Page Layout view. For other sheet types, such as chart sheets,
or for embedded charts, you can work with headers and footers in the Page Setup dialog box.

Add A Predefined Header Or Footer
For worksheets, you can work with headers and footers in Page Layout view. For other sheet types, such as chart sheetsor
for embedded charts, you can work with the headers and footers in the Page Setup dialog box.
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Add A Predefined Header Or Footer To A Worksheet In Page Layout View
Mouse

1. Click the worksheet to which you want to add a predefined header or footer.
2. On the Insert tab, in the Text group, click Header & Footer.
3. Excel displays theworksheet in Page Layout view. You can also click Page Layout View on the
status bar to display this view.

4. Click the left, center, or right header or footer text box at the top or at the bottom of the worksheet page.
5. Clicking any text box selects the header or footer and displays the Header and Footer Tools, on
the Design tab.

6. On the Design tab, in the Header & Footer group, click Header or Footer, and then click the
predefined header or footer that you want.
7. To return to Normal view, on the View tab, in the Workbook Views group, click Normal. You can also
click Normal on the status bar.
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Add A Predefined Header Or Footer To A Chart
Mouse
1. Click the chart sheet or embedded chart to which you want to add a predefined header or footer.

2. On the Insert tab, in the Text group, click Header & Footer.
3. Excel displays the Page Setup dialog box
4. Click the predefined header or footer in the Header or Footergroup.
Add Or Change The Header Or Footer Text For A Worksheet In Page Layout View
Mouse

1. Click the worksheet to which you want to add headers or footers, or that contains headers or footers that
you want to change.
2. On the Insert tab, in the Text group, click Header & Footer.

3. Excel displays the worksheet in Page Layout view. You can also click Page Layout View on the status bar to
display this view.
4. To add a header or footer, click the left, center, or rightheader or footer text box at
the top or at the bottom of the worksheet page. And either:
5. Type the text that you want.
6. Insert a header or footer element if you want from the header and footer elements groupon the
design ribbon.
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7. To change a header or footer, click the header or footer text box at the top or at the bottom of
the worksheet page that contains header or footer text, and then select the text that you want to change.
8. To start a new line in a header or footer text box, press ENTER.
9. To delete a portion of a header or footer, select the portion that you want to delete in the header
or footer text box, and then press DELETE or BACKSPACE. You can also click in the text and then press
BACKSPACE to delete the preceding characters.
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10. To return to Normal view, click on the worksheet and then click on the normal view button on the
View tab, in theworkbook views group. You can also click Normal on the status bar.
•

To include a single ampersand (&) within the text of a header or footer, use two ampersands.

•

E.G., to include “Subcontractors & Services” in a header, type Subcontractors && Services.

11. To close the headers or footers, click anywhere in the worksheet, or press ESC.

Choose The Header And Footer Options
For worksheets, you can work with headers and footers in Page Layout view. For other sheet types, such as chart sheetsor
for embedded charts you can work with headers and footers in the Page Setup dialog box.
Choose The Header And Footer Options For A Worksheet
Mouse

1. Click the worksheet for which you want to choose header and footer options.
2. On the Insert tab, in the Text group, click Header & Footer.
3. Excel displays the worksheet in Page Layout view. You can also click Page Layout View on the status bar to
display this view.
4. Click the left, center, or right header or footer text box at the top or at the bottom of the worksheet
page.
5. Clicking any text box selects the header or footer and displays the Header and Footer
Tools,as the Design tab appears.
6. On the Design tab, in the Options group, select one or more of the following:

7. To insert a different header or footer for odd pages on an odd page and for even pages on an even page,
select the Different Odd & Even Pages check box.
8. To remove headers and footers from the first printed page, select the Different First Page check box.
9. To use the same font size and scaling as the worksheet, select the Scale with Document check
box. To make the font size and scaling of the headers or footers independent of the worksheet scaling for a
consistent display on multiple pages, clear this check box.
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10. To make sure that the header margin or footer margin is aligned with the left and right margins of the
worksheet, select the Align with Page Margins check box. To set the left and right margins of the
headers and footers to a specific value that is independent of the left and right margins of the worksheet,
clear this check box.
11. To return to Normal view, on the View tab, in the Workbook Viewsgroup, click Normal. You
can also click Normal on the status bar.
Choose The Header And Footer Options For A Chart
Mouse

1. Click the chart sheet or embedded chart to which you want to add a predefined header or footer.
2. On the Insert tab, in the Text group, click Header & Footer.
3. Excel displays the Page Setup dialog box.
4. To insert a different header or footer for odd pages on an odd page and for even pages on an even page,
select the Different Odd & Even Pages check box.
5. To remove headers and footers from the first printed page, select the Different First Page check box.
6. To use the same font size and scaling as the worksheet, select the Scale with Document check
box. To make the font size and scaling of the headers or footers independent of the worksheet scaling for a
consistent display on multiple pages, clear this check box.
7. To make sure that the header margin or footer margin is aligned with the left and right margins of the
worksheet, select the Align with Page Margins check box. To set the left and right margins of the
headers and footers to a specific value that is independent of the left and right margins of the worksheet,
clear this check box.

Custom Header Or Footer For A Chart
Add Or Change The Header Or Footer Text For A Chart
Mouse
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1. Click the chart sheet or embedded chart to which you want to add headers or footers, or that contains
headers or footers that you want to change.
2. On the Insert tab, in the Text group, click Header & Footer. Excel displays the Page Setup dialog
box.

3. If none of the predefined headers and footers are what you want, you can customise them using the
Custom Header and Custom Footer buttons. When you click either of these buttons, Excel gives
you a dialog box representing either the top (Custom Header) or bottom (Custom Footer) edge
of your page.
4. ClickCustom Header or Custom Footer.
5. Click in the Left section, Center section, or Right section box, and then click the buttons
to insert the header or footer information that you want in that section.
6. To add or change the header or footer text, type additional text or edit the existing text in the Left
section, Center section, or Right section box.
7. To start a new line in a section box, press ENTER.
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finance, to strategy, customer support, marketing and sales.
Positions are available in France, Germany, Spain and the UK.
To find out more and apply, visit www.jobs.eads.com. You can also
find out more on our EADS Careers Facebook page.

Download free eBooks at bookboon.com

65

Click on the ad to read more

Excel 2010 Introduction: Part II

Printing

8. To delete a portion of a header or footer, select the portion that you want to delete in the section box, and
then press DELETE or BACKSPACE. You can also click in the text and then press BACKSPACE to delete
the preceding characters.
•

To include a single ampersand (&) within the text of a header or footer, use two ampersands. For example, to
include “Subcontractors & Services” in a header, type Subcontractors && Services.

•

To base a custom header or footer on an existing header or footer, click the header or footer in the Header or
Footer box.

You can type text into the left, centre and right sections, but if you want information to change dynamically according
to alterations you make to filenames, sheet names or you want to always display the current date and time in the header
(useful for seeing when a worksheet was printed),the dialog has buttons that generate codes. The codes instruct Excel to
include information where you have positioned them and will update if the information that they generate changes. The
diagram below details what each of the buttons do.

To make sure that the header margin or footer margin is aligned with the left and right margins of the worksheet, select
the Align with Page Margins check box. To set the left and right margins of the headers and footers to a specific
value that is independent of the left and right margins of the worksheet, clear this check box.

Sheet Tab
The Sheet tab has many settings that you can use to select what appears on the printed sheet. You can also use this tab to
set a print area, (useful if you do not want the whole worksheet to print) and print titles.
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Some settings on the Sheet tab are only available when you access the Page Setup dialog from the layout ribbon.
If you are accessing it from the Print Preview window, you will not have access to the Print Area and Print
Titles settings.

Print Area
Use this to set the range of cells that you want to print. If you do not set a Print Area, Excel will print all the data on the
active worksheet.
To Set A Print Area:
Mouse

1. Click the dialog box launcher. From page setup group on the page layout ribbon, select
the sheet tab ,
2. Click the button on the right of the Print Area box to collapse the Page Setup dialog so that you can
see the worksheet
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3. Select the cells you want to print and click the Expand button to go back to the Page Setup dialog
4. The selected cells will appear listed in the Print Area dialog. Click OK to close the dialog and save the
settings – next time you access Print Preview, the new settings will be displayed.
OR

360°
thinking

5. Click on print area From page setup group on the page layout ribbon and select set print

.

area.

You can use the Set Print Area option to set the selected cells to the print area as an alternative to using the Page Setup
dialog.

360°
thinking

.

360°
thinking

.
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To Clear The Print Area:
Mouse

1. Click the dialog box launcher. From the page setup group on the page layout ribbon,
select the sheet tab, Delete the values from the Print Area.
OR
2. Click on theprint areabutton From page setup group on the page layout ribbon and select
clear print area.

Print Titles
When your printouts run to several pages you may have column and row headings that you would like to print on each
new page. The diagram below shows a four page printout where the months have been set up to print at the top of each
page and the years at the left of each page. Excel allows you to specify any number of rows and columns to repeat when
you have a multi-page printout.

To Set Print Titles:
Mouse
1. Access the Page Setup dialog From the page setup group on the page layout ribbon then Click
the Sheet tab.
OR
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2. Go to the page setup group on the page layout ribbon, and select the Print titles button. This
will open the page setup dialog box at the sheet tab
3. Click the button on the right of the Rows to repeat at top box to collapse the Page Setup dialog
so that you can see the worksheet (see diagrams) Select the rows you want by dragging over them with the
selection pointer.
4. Click the Expand button to return to the Page Setup dialog. The rows you selected will be referenced in the
Rows to repeat at top box.
5. Repeat steps (selecting columns not rows) asabove for the Columns to repeat at left box if
required.
6. Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.

Print
The settings here allow you to choose whether to print gridlines, row and column headings and so on. If you choose not
to print gridlines, Excel will print any borders you formatted your cells with the diagrams below illustrate some of the
effects of activating certain settings.
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To Change Sheet Tab Print Settings:
Mouse
1. Access the Page Setup dialog and click the Sheet tab.
2. Check the boxes under the Print heading until you have the combination of settings that you require.
3. Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.
Page Order

When you have multiple pages to print, each with a printed page number, you can control the order that the data prints
on the pages using the Page Order settings.

We will turn your CV into
an opportunity of a lifetime

Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com
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The diagram below shows how pages will have different numbers according to which setting you choose.

To Change Page Order:
Mouse
1. Access the Page Setup dialog and click the Sheet tab.
2. Click the option button in the Page Order section for the order you want the pages numbered.
3. Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.
•

The Page Setup dialog saves print settings for the active sheet only. If you want several sheets to have the same
print settings, select them before you access the Page Setup dialog.

Page Breaks
If you do not get page breaks to fall where you want them with the scaling options, you can insert them manually. Excel
lets you put in both horizontal and vertical page breaks.
To Insert A Horizontal Page Break:
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Mouse

1. Select the cell in column A below where you want the page break.
2. Choose breaks from the page setup group on the layout ribbon then click Insert Page Break.
A dotted line will appear above the active cell – this represents the page break.
To Insert A Vertical Page Break:
Mouse
1. Select the cell in row 1 to the right of where you want the page break.
2. Choose breaks from the page setup group on the layout ribbon then click Insert Page Break.
A dotted line will appear to the left of the active cell – this represents the page break.
•

If you insert a page break when you are not in either the first column or row, Excel will insert both a horizontal
and vertical page break above and to the left of the active cell position.

To Remove A Page Break:
Mouse
1. Select the cell immediately below and/or to the right of the page break.
2. Choose breaks from the page setup group on the layout ribbon then click remove Page Break.
The page break will be removed
3. If Reset All page breaks is selected then all page breaks will be removed
•

If the Fit To option is active in the page setup dialog, you cannot set manual page breaks.
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Excel will print all data on the selected worksheet (unless you tell it otherwise by setting a Print Area). If you want to
print more than one worksheet, select the sheets you want first, before you click the Print button.
To Print The Active Worksheets:
Mouse
1. Click the worksheet that you want to print.
2. Click the FILE ribbon, click Print, Or Press CTRL+[P]
3. Choose print active Sheetsfrom the drop down box.
4. Click Print
To Print A Specific Worksheet Page Or Range Of Pages:
Mouse
1. Click the FILERIBBON; click Print, Or Press CTRL+[P].

2. Type in the page number that you want to start at in the Pages box and the end page number in the To
box.
3. Click Printto launch the print
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To Print The Entire Workbook:
Mouse

1. Click the FILE ribbon, click Print.Or Press CTRL+[P]
2. Select print entire workbook from the drop down box
3. Click Printto launch the print
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To Print The Selection:
Mouse
1. Select the cells you want to print.
2. Click the FILE ribbon, click Print.Or Press CTRL+[P]
3. Choose the Print Selection option button from the drop down box.
4. Click Print to launch the print.

Copies
By default, Excel will print one copy of the item you have sent to print. You can print multiple copies by changing the
Print dialog settings. When you print multiple copies of a document, Excel lets you choose whether the copies are collated
(Excel prints each whole document before it starts on the next copy) or uncollated (Excel prints however many copies
you have requested of each page).
To Print Multiple Copies:
Mouse

1. Click the FILE ribbon, click Print.Or Press CTRL+[P]
2. In the Copies section of the window, use the up and down arrows to the right of the Number
ofcopies text box to set the number of copies you require.
3. Set the Collate check box by clicking in it to change the current setting.
4. Click OK to launch the print.
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Section 11	Utilising Large Worksheet
By the end of this section you will be able to:
•

Split screen

•

Freeze panes

•

Use zoom controls

•

Use name box to navigate

•

Use goto
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Useful Tools for Large Sheets
Split Screen

The visible worksheet area is relatively small. If the data you are working with spans a large number of columns and rows,
you may find it difficult to move and copy information between areas, or even to view data in non-adjacent columns or
rows on the same screen. Splitting the screen gives you the ability to scroll the data one side of the split independently of
the other side – so you could be viewing cells Z100 – AH116 on one side of your screen, and cells A1 – G16 on the other.
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To Split The Screen Horizontally:
Mouse
1. Position the mouse along the top edge of the upward pointing arrow at the top of the vertical scroll bar –
your pointer should display as shown in the diagram above.
2. Drag down – you will see a fuzzy line that follows your mouse down. Release the mouse when the line is at
the position you want to split the screen.
To Split The Screen Vertically:
Mouse
1. Position the mouse along the top edge of the upward pointing arrow at the right of the horizontal scroll bar
– your pointer should display as shown in the diagram above
2. Drag left – you will see a fuzzy line that follows your mouse across. Release the mouse when the line is at
the position you want to split the screen.
3. When the screen is split, you get scroll bars in each horizontal or vertical section of your window which you
can use to move the display for just that section.
To Apply Both Splits At Same Time
Mouse

x

1. Go to the window group on the view ribbon and click on the split button
2. Both horizontal and vertical splits will be applied at the same time. These can be adjusted by positioning the
mouse over one and dragging in the desired direction
To Remove A Split:
Mouse
1. Position the mouse over the split.
2. Drag a split back up until it is flush with the column or row letters or numbers and release the mouse,
OrDouble click on the split
OR
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1. Go to the window group on the view ribbon and click on the split button

Freeze Panes
When you want certain rows or columns to remain static on screen while you scroll down or across data on a worksheet,
you can use freeze panes.

To Freeze Panes:
Mouse
1. Select the cell below and to the right of the cells you want to freeze.
2. Go to the window group on the view ribbon and click on the freeze panes button
3. Make a selection
•

If you only want the freeze for rows, select the cell in column A below the rows you want to freeze. If you only
want the freeze for columns, select the cell in row 1 to the right of the columns you want to freeze.
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To Unfreeze Panes:
Mouse
1. Go to the window group on the view ribbon and click on the freeze panes button
2. Select Unfreeze panes

Zoom
You can adjust the scale of the on-screen display with the Zoom command. Excel allows you to specify any percentage
between 1 and 100 for viewing on-screen data. If there is a particular range that you need to make visible on one screen
without scrolling, you can use the Fit selection option.
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To Zoom Screen Display:
Mouse
1. In the bottom right hand corner of the screen click on the Plus or minus buttons to zoom in or out of
your spreadsheet
OR

1. Click on the percentage button on the bottom right hand corner of your screen and a dialog box will
open.
OR

1. Click on the zoom button on the view ribbon in the zoom group.
2. A dialog box will open.
Either
1. Choose a percentage from the dialog box
2. Click OK to apply the zoom and close the dialog.
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OR
1. Highlight the percentage figure currently displaying in the Custom Zoom text box and type the
figure you want to use.
2. Click OK to apply the zoom and close the dialog.

Navigation
Go To
The GOTO feature can be used to go to a specific cell address on the spreadsheet. It can also be used in conjunction
with names.

To GO TO A Name:
Mouse
1. Click the find &SELECT button on the in the editing group on thehome Ribbon.
2. Select Go to
3. The following dialog appears
4. Click on the name required, then choose OK.
OR
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Keyboard

1. Press [F5]. The following dialog box appears;
2. Click on the name required, then choose OK.
Not only does the cell pointer move to the correct range, but it also selects it. This can be very useful for checking that
ranges have been defined correctly, and also for listing all the names on the spreadsheet.
You can also go to a specific cell that has been used in two range names. The previous example mentioned cell C6, the
intersection of the FEB and Britain ranges.
To Move To A Cell That Belongs To Two Ranges:
Keyboard
1. Press [F5] and type the first range name in the Reference box, then type a space and the second range name.
2. Click OK. The pointer immediately jumps to the correct cell.
To Go To Locations In Workbook Based On Different Criteria Than Names.
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1. Press [F5] and click the special button. The following dialog appears
2. Make a selection and click on OK
3. All cells of those criteria will be selected.
4. Use return or tab keys to move around.

Navigating With Name Box
If you wish to travel to a point on your spreadsheet you know the reference of then the name box can be used to enter
a cell reference and it will take you there. Since it IS called the name box any named cells or ranges throughout your
workbook can be moved to merely by choosing it from the name book.
To Use Name Box For Navigation
Mouse

1. Click in name box
2. Type cell reference
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Press return
OR
3. Click drop down arrow to right of name box
4. Select a name to take you to that location

.
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Section 12 Customising Excel
By the end of this section you will be able to:
•

Access and change Excel settings

•

Create excel ribbons

•

Edit existing ribbons

•

Edit quick access toolbar

•

Set language choices

•

Set defaults for Excel
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Set Excel Options

Options are set very differently in Excel 2010
Click the FILE ribbon, Click the excel options button to open the dialog box above
General
This sheet allows you to turn off the mini toolbar that appears whenever you right click on a cell or range plus other
basic options
You may put in a different username which by default is the logon for windows
You may change the deault number of sheets from three to whatever you wish the limitations of excel will be in the next
chapter
You may even change the colour scheme for excel windows (not dialog boxes)
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Formulas Sheet
This sheet allows the setting of options that changes the way excel will calculate your sheets and workbook

Proofing
It is here on the Proofing sheet that the spell-check and grammar options are set for excel.
It also has the options for the autoformatting and autocorrection of entered text
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Save
Save is an important sheet since excel 2010 saves in a completely different file format this sheet gives global options on
what filetype to save the file as and where to save files by default. This sheet also has the autorecover options for
where and how your files will be autosaved should windows crash. This saves your work regularly and automatically
and should recover work should the worst happen.
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Language
Clicking the language settings button allows the setting of the default language not just for excel but for all the office
programmes. It will allow you to change not only the tyed language but the display and help language
Even your screentip language can be set from here
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Advanced Options
These are all the options on the advanced sheet there are too many to go into but should be useful for reference
Editing custom lists for various usages such as drag fill, series and sorting can be done from this sheet
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Customise Excel Ribbons
New to 2010 is the ability to customise existing ribbons and create new ribbons with all the most useful tools for the way
you work with excel. These customisations can be exported and imported into other computers using excel 2010 or simply
store the exports in case your machine has to reinstalled. Then simply import your customisations into the new installation.

To create a new ribbon
Mouse

1. Go to the file ribbon and open the excel options from the button on the below left.
2. Go to the customise ribbon button the dialog box above will be seen.
3. Click on the new tab button a new tab will appear in the right hand frame
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4. Use the arrow buttons on the far right to position the tab where you wish it to appear.
5. Click on rename.
6. Give your tab a name and press ok.
7. Select the custom group on your created tab
8. Click rename
9. Select an icon and name the group then click on OK
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10. You may add several groups onto your tab if you wish, just rename each of them with appropriate labels.
11. Now you may drag the buttons you wish from the box on the left onto your group on the right.
12. If you cannot find a button you wish, go to the drop down box at the top of the commands and select the
all commands option for example or commands not in the ribbons. You will now have
other buttons you may wish to use

13. When all the buttons have been added that you wish You will end up with your own ribbon on the right
with the commands you would most like to access easily.
14. When you click ok you will find your ribbon amongst the others selecting it you will be able to use the
commands you have added.

You may use the same method to edit existing ribbons
To show or hide a ribbon
Mouse
1. Access the excel options from the file ribbon
2. Go to the customise ribbon button
3. Tick or untick the tabs in the right hand box to show or hide ribbons from use.
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Customise Quick Access Toolbar

This is the location where you are able to customise the quick access toolbar (above the file ribbon) and add your
most often used buttons to it.
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To customise quick access toolbar
Mouse
1. Open up the excel options dialog from the file ribbon
2. Go to the quick access toolbar button on the left
3. From the drop down arrow on the top left of the box you may choose which group of commands you may
wish to see.
4. Select the buttons on the left and click on the add button in the middle to move them to the toolbar.
5. If you make a mistake then select the button on the right and click remove.
6. Once all the buttons you want are on the right hand side click ok to finalise your choices and apply them.
7. You may click on reset at any time to return to the default quick access toolbar
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